Quick Start

Get started sending messages to your sign fast!

Sending the first message to the sign

Quickly send your first message to the sign.

To send a message to the sign
1. Open the sign software.

Double—click the desktop shortcut icon.

A new blank message will appear in the Message
Editor screen.
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2. Right—click the Emulation Area (black area) and
select Insert Text to Time.

Paste

Select Background

Insert Text ko Timeh

Insert background

A text message box “New 1" appears in the
Emulation area and Frame Sequence TimeLine.
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3. Click inside the message box, delete the current
text, and type a message to appear on the sign.
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4. Click the Save icon and save the message.
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5. Click the Send message icon.
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Adaptive recommends that you review this entire guide and explore more of the sign
software features. The more familiar you become with the sign software the more
dynamic and effective your electronic message center will be.
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Overview

Overview

Create basic text messages, messages with animations or graphics, and messages with both text and graphics or
animations. The sign software supplies a variety of tools for creating and scheduling messages, as well as the
ability to preview the message on your monitor before sending them to your sign for display.
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Note: Some messaging features shown in this guide may not appear if you have an EzView sign.
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Workspace and message file options

Workspace and message file options

Set up the workspace

Customize the software window by selecting the items
you want to appear in the Message Editor screen.

From the View pull-down menu, select the features you
would like to appear in the Message Editor screen.
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For the purpose of this guide we will use the default
layout.

Open, close, or save messages

There are several ways to open, close, and save
messages, choose one that works best for you:

» Choose from the list below Message Editor
* or select an icon located in the toolbar
* or use the File pull-down menu

File pull-down New, Open, and Save icons.
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Message Editor option list

Several messages can be open but only one can be
active for creation or editing. Each message will have a
separate tab located near the middle—left of the screen.

edule | s ' L
aphic
Tools | Weeks Giveaways | Happy Holidays | Time and Temp]

Tip: Itis good practice to save your work on a
consistent basis during message creation or editing.

Text message effects and options

Create simple or flashy text messages very easily with
the sign software’s effect options.

Always consider your target audience when creating

messages and how much time they will have to view a
sign message. For example, a long scrolling message
is not ideal for potential customer’s driving by in a car.

Create text messages

1. Open a new message.

2. Add a text box to the message. Choose the method
that works best for you.

» From the Insert pull-down menu, select Text.

Insert| Yiew Language
Background 3
Text
Date...
Time. ..
Temperature, .,
Syrbal. ..

« or right—click in the Emulation Area and select
Insert Text to Time.

Paste

Select Background

Insert Text to Timeh

S——

* or right—click in the Frame Sequence section
(white area) and select Insert new text.

Insert background

Timeline — #(=1#) s
l‘j Text
Copy
ﬁ Background Cuk
Paste
o Text Insert new text
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Text message effects and options

3. Atext message box will appear in the Emulation

area and in the Frame Sequence TimeLine.
Text message box
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Text tab Scroll bar

If the Text tab is empty simply click the text message box in
the Frame Sequence section to activate the message box.

. Inthe Emulation area, click inside the text box and

delete the current message.

Tip: To select all the text, click inside the text box

and simultaneously press the CTrL+A keys, or

right—click in the text box and choose Select All.
v
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. Type a message and use the Text tab tools to
customize the message (only the selected text
will accept the chosen effects).

The Text tab tools include:

» Font options — change the font type, font size,
color of font or the background of the text box,
character transparency, and spacing.

Font

(sl |

Size: 1/2  swe—— Fontsize is
proportionate to

Colar: I:‘ Background: I:' the height of
the sign.

Character Spacing

[ Set as Defaulk _]

Tip: If most messages will be using the same
font settings, make them your default. Make the
desired changes and click the Set as Default

button. All new text messages opened will use the

default settings.

» Shadow options — create a drop shadow around
the selected text in any depth, direction, color, or
transparency.

Shadow

Depth:
Q
Direction: ®

Color:

| | Full shadow

» Alignment option — change the text position
inside the message box or change the Font style.

Alignment
@ @ @ —— Justify text
@ @ [Q —— Text vertical
Font style alignment
(8] (7] [A] |~ Bold, talic, and
Flash effect.

» Appearance Effect option — dictate how the text
will first appear in the message. These effects
only occur once in the message.

Appearance Effect ‘
EFffect: [Nnne -]T Effect options
Direction: [ ""]— Direction
dictates how
5 - the Effect
(1] 35 . .
Speed: [ option will
appear.

Speed option dictates how quickly the
Effect option appears in the message.
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Background layer effects and options

» Hold Effect option — impacts how the text will
appear in the message.

Effect options

Hold Effect

SEsd D:'”E l Hold Time adjusts
Hold Time: [00:00:02:0 wass— the message

timeline length.
Direction: -\
Direction dictates

Sla Fast

SDEEd: H

how the Effect
option will appear.

Speed option dictates how quickly the
Effect option appears in the message.

Note: The Hold effect option will repeatedly
appear during one message time frame when
used with an Appearance effect. The Hold effect
always appears after the Appearance effect.

* Run-time objects options — include time, date,
temperature, counter properties, RSS feeds,
character objects, and add text box buttons.

Date
Temperature
Run-time (| bjects
Time T‘q @ ﬁ] m *Count_er
*RSS m properties
feed Objects
Add _fa @

character | ‘

Add new text message box
* Not available on EzView signs.

6. If applicable, adjust / move the text message box.
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4— Adjust the text box size, hover the cursor over a square
drag point until it changes into two arrows, click and drag
to stretch the box in either direction.

Move the text box, hover the cursor over the text box
border until it changes into four arrows, click and drag the
text box in any direction.

Tip: Double—click when the four or two arrow cursor
appears to fill the entire Emulation area.

7. Preview the message in the Emulation area,

Click the Play button.

if necessary extend the message TimeLine.
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TimeLine
i
j Text

4—# Hover the cursor over the right edge of the message
box, click and drag to the desired time length.

8. Click the Save icon and save the message.
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9. Click the Send message icon.

Tools  Help
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Background layer effects and options

The background layer is used to set a background color,
pre—designed images, or animations within the sign
message; text can also be applied to this layer.

Note: Only the following file types work with the sign
software: *_BMP; *.GIF; *_.JPG; *.JPEG;
*_PNG; *.AVIl; *_MPEG; *_MPG

Create a background layer

1. Create a background layer using one of several
options, choose one that works best for you:

» From the Insert pull-down menu, select
Background and choose either From file or
Color.

Insert| View

Background From File. ..
Text Color
Date... ——

Language Tools Help

Time...
Temperature...
Symbol...

From file — opens the last folder accessed.
Color - opens a new background layer for color.
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Background layer effects and options

« or select the Insert background icon, and choose » Location option — shows the file name being
either From file or Color. used and the ability to embed the file.
Took - Help Location

i)

u o, | Auto b
! From file... File: | Browse File directory
il

+ | Background color l’ pthway of th? file
being used will
From file — opens the last folder accessed. appear here.
Color - opens a new background layer for color. (m

« or right—click in the Emulation Area and select
Insert background.

Embed the file into the background layer.

» Appearance Effect option — dictate how the text
will first appear in the message. These effects
only occur once in the message.

Paste

Select Background

Insert Text ko TimE[\P Appearance Effect ‘
—‘ Insert background EFfoct: [N e _‘}_ Effect options
2. In the Message Editor screen, the following options _— [ oot
. Direction: - Direction
used to create the background layer appear: dictates how
Background layer the Effect
Sl Fast i il
=/ wa B N SI:IEEd: Uﬁ! op on wi
S S T ‘ appear.
Bl R Speed option dictates how quickly the
g = Effect option appears in the message.
- » Hold Effect option — impacts how the
background will appear in the message.
- = e ui?:': g Effect options
| E— Hold Effect -J-
Background tab Effect:  [None | Hold Time adjusts
If the background tab is empty simply click the Background Hald Tirme:  [00:00:02:0 -u—: the message

timeline length.

layer in the Frame Sequence section to activate the layer. o
Direction: | -\|
Direction dictates

Tools in the Background tab include:
Slo Fast

» Type option — change the background color, Speed: [} —————— how the Effect
choose a pattern, or select a file to insert. option will appear.

Type | Click the box to
open the Color Speed option dictates how quickly the

(®) Colar: swatch window. Effect option appears in the message.

= 3. Preview the message in the Emulation area, if

| Wb el _ ;J;?Ogattern necessary extend the message TimeLine.
OFi 4. Click the Save icon and save the message.

_/File:
5. Click the Send message icon.

Selecting File will open the last folder accessed
and unlock the Location option.
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Adding time, date, or temperature to messages

Adding animation files to a message

1. Open a new message.
2. Click the Media Library tab at the bottom of the
window.
Image Category —
-] (Eallesls)

[Sample images
4] M

coffeed6x4ar, Sl memorialdtx
GB.bmp 48RGE.bmp

_| Background |Med|a Library
3. Click and drag a file onto the Emulation area.

If the following prompt appears, click Yes.

?/ Would you like to fill screen?

The Emulation area will be filled with the animation.

4. Preview the message in the Emulation area, if
necessary extend the message TimeLine.

5. Click the Save icon and save the message.
6. Click the Send message icon.

Adding text to the background layer

Text message boxes attached to background layers can
only have a timeline as long as the background layer it
is attached to.

1. Create a Background layer.

2. Right—click the Background layer and select Insert
new text.

Backgrou

Zut
Copy
Paste

Delete

||

Insert mew text

The following appears in the Frame Sequence:

EEE

Timeline

=] Text

Backagrou

ﬂ Background

T Mew]
o Text

This text message box is attached to the background layer.

Adding time, date, or temperature to
messages

Time and Date messages are synchronized with the
computer’s settings as the default settings but is only as
current as the last sign command sent. Refer to “Sign
command features” on page 10 for more details.

NOTICE
If you are messaging with an EzView sign DO NOT use
animation files or scrolling text with Time, Date, or
Temperature messages.

The sign must have the optional temperature sensor
installed in order to use the temperature message option.

Add time, date, or temperature to messages

1. Open a new message.

2. There a few ways to add time, date, and
temperature messages, choose one that works best
for you.

* From the Insert pull-down menu, select either
Date, Time, or Temperature.

Insert Yiew Language Tc

Background LN
Text |

Date...

—-—
Time. .. k

Temperature. ..

Symbal...
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Working with multiple text message boxes and background layers

» Open a text message box (or click on an existing
box) and select one of the icons.

Run-time objects

Scroll down in the
Text tab options to
locate the icons.

| | ¥

Dbijects
e

Text Backgmv:l}'nd l Media Library I

3. One of the following prompts will appear, choose
the format and click Ok.

Date prompt: Time prompt:
Select date fomat Time format ()
fﬁ - Select time format
Select view of date G4 P
(01/07/09 - 314 PM
15:14
31412 PM %
15:14:12 neel
Ok || Cancel |

Temperature prompt:

Select temperahure fommat:
®) Fahreniheit

Celcius

V| Use degres symbol

ok [ Cancel

Tip: Ensure the text box is large enough so all
characters will appear. For example, if it is 1:00 PM

now, make sure you leave enough room for 12:59 PM.

4. Preview the message in the Emulation area, if
necessary extend the message TimeLine.

5. Click the Save icon and save the message.
6. Click the Send message icon.

Working with multiple text message boxes
and background layers

Several text messages with different effect options can
be used in one message but use caution not to overlap
text / objects in the Emulation area if they will appear on
the sign at the same time.

For example, the message in box 3 will appear on the
sign before the message in box 2 is finished playing.
This is okay as long as the text does not overlap.

To move message boxes or background layers, click /
hold and drag message boxes to the desired placement
in the message TimeLine.

Schedule messages on the sign

Schedule multiple messages to appear on a sign.
Individual messages can be scheduled for daily, weekly,
or monthly depending on your requirements.

Scheduling messages on the sign

1. Click Schedule on the left of the sign software
window, the following screen will appear.

B oohMedia 2009

File  Sign

Langua

Sign Management:
Shows all available signs.

Sign1 - Sign Managemen|

A Message
E Editor

Sigh/Group

You can Edit, Delete,and ;7 i CF E
Add sign information as ? )) ) w8 Sion E
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Current Message
Schedule:

Add and remove
messages for sign’s
selected in the Sign
Management section.

Legend

EA

Add Messages | | e

Schedule:
Set the message schedule

Recurrence

for the message selected

(®) always
in the Current Message Opaily
Schedule section. O weekly

(.::'Monthly

('_';' Inactive

2. Select a sign in the Sign Management section.

3. Click Add Messages button in the Current
Message Schedule section. Select messages you
would like to schedule on the sign, click Add.

Tip: To select multiple messages, press and hold
the CTrL button, select messages with the cursor.

Add Message

= 3 (i)
- J
Hagow Naws Vi 2h e 1

VSO0 | AT P

. A ——
T P —
o ich WeE TEE I M

Flename |

[aoa ][ oo )

Messages listed in the Current Message Schedule:

o

oooan

Tip: Double-click any message to open it.
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Schedule messages on the sign

4. Select the message you would like to schedule and

choose one of the Recurrence options.
The following Recurrence options include:

» Always — the selected message will consistently
appear on the sign in a rotation with other
messages sent to the sign.

Recurrence
(f}nlways | Apply changes
Opaily
O weeldy
O monthly

Oinactive

» Daily — the selected message can be scheduled
to appear during specific times on a daily basis.

Recurrence Time Range of Recurrence
Oalnays start (1200AM  bed| | Start: (01122000 wed) #pply shangss
®paily Endi [1150FM  be|| End:
\j,'Week\v (OMNoEndDate
() Monthly .
- (OEnd After
Onactive -
Every -~ =
R

01.12.2009 &

* Weekly — same features as the daily option but
specific days during the week can be chosen (for
example every other day).

I
Recurrence | Range ol

Alwars Storty Roely hanars

| Croaty Hunder

By

Tuesday
Wednesday

* Monthly — same features as the weekly option
but specific days during the month can be
chosen. Select calender dates numerically (1st
through the 31st) or specific days of the month
(for example every first, third, and fifth
Wednesday).

Recurrence Tims [ Range of Recurramcs [remm——— |

LR AUAERERL

T A T

iy B G RE
T

Almays Start

| M| ot [@.22009 0| | @pery day
| Croaty

End.

[

M Ered D

Apsly changes

* Inactive — removes the message from the
schedule but does not delete the message.

Recurrence -
Oalways | &pply changes
ODaily
Oiveekly
O Monthly

L'E,'Inact\ve

5. After completing the message recurrence schedule,

click Apply Changes. If necessary repeat the
previous step for each message.

NOTICE
The sign must be powered on and connected to the
PC before you can send message schedules from
the computer.

. In the Sign Management section, click Send

Schedule button. The selected sign will be updated
with the new message schedule.

Sign/Graup | Madel ‘ Size | |P Address ‘ Last Updated
o CE Ez\iew 48496 RGB 48296 10.11.11.254
5 Signl Excite 43296 RGE 43%96 localhost
Ls d
e EE unknown ER emar EE progress EE success
Edit Delete Add [ Commands J [ Get Schedule J [ Send Scheduls J |

Click Send Schedule.

7. The new schedule will be sent to the sign and a

green box will appear next to the sign name
indicating the sign accepted the new schedule.

SigndGroup | b odel
Green CE EZview 48436 RGE
SUCCEss Sign1 Excite 48196 RGE
box ## Sign woike 4o
Legend

Linknown

[ Edit J[DeleteJ[ &dd J [_
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Sign management options

Sign management options To delete a sign
Manage the sign settings from the Sign management 1. Select a sign and click Delete.
section. 2. Click Yes, when the following prompt appears.
To edit or add a sign [stop x]
A maximum of 10 .signs can be listed in the Sign A Dmgramsodl e A cbed
Management section. 2 Signe?
1. Click the Edit or Add button. vee [ e ]
Sign/Group Madel Size IP A Slgn command features
- FeE AR o """ change or update the time and date settings, sign IP
#E Signl Excite 45236 RGE 48496 localhe address, password, or clear sign memory.
Legys 1. Select a sign and click the Command button.
[ Edit J [ DeleteJ [ Audd J [ Commands J [ Ge Sign/Graup Model Size IP Add
CE Eé\fiew 4895 RGE 4836 101111,
% Signl Excite 48296 RGE 48496 localhost
NOTICE
Legend

unknown

The sign must be powered on and connected to the — piogress
PC before you can add a new sign to the sign

management section. [ Edit J[Delete][ Add J [ Commands J Get 5

2. Enter the sign’s IP address and click the Auto

Detect feature. The software will automatically fill in NOTICE
the sign’s information. The sign must be powered on and connected to the

PC before you can send command changes or

C. Assign a name to the sign updates to the sign.

Sign Options &) 2. Choose the command you would like to change,
Sign Configuration make your changes, and click the Send button.
o] , :
Farmily: [EHCitB 'q lcnmcls — lﬁl}
A atriss: Height: W’idth: pixels St Time and Date () Synchronize with the PC
Murnber of Faces: [Master '-'] Sox Mooy Osetto ——— IRHAESE

Set|
Color: AGE o [ﬁ = mmopaeery
IGNJe Fasswon
Communication Type: [Ethemet -—-] Send
Sign Communicabion
P addresz/Host name: [Iocalhost ] |
P! B ] Sign commands ~ Each command has a Send button Fhat
releases changes / updates to the sign.
NOTICE
Auto Netect When National Time changes occur such as Daylight

savings time, you must:

: 1. Send a Set Time and Date command update to your
TN EE=D sign; even if it is set to Synchronize with the PC.

2. Re-send your current sign message schedule to
reflect the new time change. Repeat this procedure for
each sign.

A. Enter the B. Click Auto D. Click Apply.
sign’s IP address  Detect.
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